
   
 

 

Conception SWOOD – Cost dans la bande de bord Tableau de référence/largeur 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Review: 

BETA 0 

 

 

 

  

SWOOD 2024 
What’s new 



 

 
 

2  

SWOOD 2024 – What’s new 

SWOOD 2024 
What’s new 

The purpose of this document is to present the new features of SWOOD 2024, to define their 
parameters and, lastly, to provide explanatory videos for certain new features, so that they 
can be better understood. 

How does this document work? 
For each software (SWOOD Design, SWOOD CAM, SWOOD Nesting and SWOOD Report), you 
can click on a bookmark, which will redirect you to the corresponding chapter in this 
document.
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SWOOD 2024 – What’s new 

Global new feature 
Simplified access to SWOOD Rx 

EFICAD's team makes its best efforts to provide software that is as stable as possible, 
however, it does happen that some software functions fail. So that end users can report 
these bugs as accurately as possible, and so that developers can understand and correct 
them; EFICAD has developed a small utility to enable this: SWOOD Rx. In SWOOD 2024, SWOOD 
Rx is available more easily, directly in the software interface. 

 
SWOOD Rx utility interface 

 

 

  



   
 

 

SWOOD 2024 – What’s new – SWOOD Design 

SWOOD Design 
  

New feature Description 

Panel Joint 

 

SWOODBox parameters on 
external panels 

 

SWOODBox origin offset 
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SWOOD 2024 – What’s new – SWOOD Design 

 

Save File by Drag&Drop 

 

Display of SWOOD Center 
model parameters 

 

Search for files in libraries 

 

Clickable links in SWOODBox 
messages 

 

New mathematical script 
functions 

 



   
 

 

SWOOD 2024 – What’s new – SWOOD CAM 

SWOOD CAM 
  

New feature Description 

New 3D Finishing (BETA) 

 

Edgeband Encoder 

 

Angle Finishing 

 

Corner Notching 
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SWOOD 2024 – What’s new – SWOOD CAM 

 

Clamex with milling tool 

 

New automatic orientation 
strategies 

 

Simplified access to "Tools 
synchronization" and "CAM 

Copy" 

 
Report option if no machining 

to be encoded 

 



   
 

 

SWOOD 2024 – What’s new – SWOOD Nesting 

SWOOD Nesting 
  

New feature Description 

Ignore grain direction 

 

Forcing four corners in part 
types 

 

Disable program recalculation 
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SWOOD Report 

 

  

New feature Description 

System Report 

 

Cutting Pattern 

 



 

 

10 

SWOOD Design – Panel Joint 

SWOOD Design – Panel Joint 
The latest SWOOD Design update introduces an exciting new feature: the creation of 
interference joints. 
Now, users can easily design complex joints, such as miter-cuts, halved-joint and mortise 
and tenon, by manipulating the intersection of two panels. This innovation makes it possible 
to customize joints with a variety of adjustable parameters, greatly simplifying structural 
design and the production of made-to-measure wood parts. 

 
Example of a project using Panel Joints 

I. How to use 
1. Panel Joint types 

There are three types of Panel Joint: 

a. The   “Halved Joint” 
The Halved Joint is a joint between two overlapping wooden parts. The cross-section of each 
part is halved at the intersection to allow the other to pass through, thus maintaining the 
continuity of the two parts. SWOOD Design's "Halved Joint" Panel Joint refers to the joint 
carried out on the edge of the wood parts, rather than on the flat. 

 
Example of de "Halved Joint" 
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SWOOD Design – Panel Joint 

The "Halved Joint” can be defined by the following parameters: 

 To obtain a "traditional" Halved Joint with straight corners, apply the following 
parameters: 

• A  “Undercut Halved Joint” type. 

• A  Tool radius of 0mm. 

Icon Name Effect Image 

 Type 

• “Classic Halved Joint”:  The end of the 
halved Joint is a semicircle the width of 
the notch. 
 

• “Undercut Halved Joint”: More elaborate 
halved Joint which, thanks to its free 
corners, allows contact between the two 
inner surfaces. 

 
 

 

 Offset Operating clearance between two panels. 

 

 
Reverse the 

direction 
Reverse the position of the joint between the 
two panels. 

 

 Tool radius* 

* Only for the "Undercut Halved Joint" type. 
 

Radius of recess created by corner 
clearance.  

 Location Joint position as a percentage of joint width. 

 

 
Use 3 axis 
machining 

Cut the panels so that they can be 
machined by a 3-axis machine. 
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SWOOD Design – Panel Joint 

 
Traditional “Halved Joint” with straight corners 

b. The  “Mortise and Tenon” 
The “Mortise and Tenon” is a traditional joint used to join two perpendicular wooden parts. 
The tenon is a rectangular projection cut into the end of one part, while the mortise is a 
corresponding recess cut into the other part. 

 
Example of a “Mortise and Tenon” joint 

The "Mortise and Tenon" joint can be defined by the following parameters:  
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SWOOD Design – Panel Joint 

Icon Name Effect Image 

 Offset Operating clearance between two panels. 

 

 
Reverse the 

direction 
Reverse the position of the joint between 
the two panels. 

 

 Tool radius 
Radius of recess created by corner 
clearance. 

 

 Mortise length 
Mortise length, without taking the offset 
(clearance) into account. 

 

 Quantity 
Number of "Mortise and Tenon" joints 
across the entire interference between the 
two panels. 

 

 Location* 

*Only when quantity equals 1. 
 

Joint position as a percentage of joint 
width. 

 

 X Offset* 
* Only when quantity equals 1. 
 

Position of end mortises (on the joint axis). 
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SWOOD Design – Panel Joint 

 To obtain a "traditional" Mortise and Tenon joint with straight corners, apply the 
following parameters: 

• A  Tool radius of 0mm. 

 
Traditional “Mortise and Tenon” with straight corners 

c. The  “Panel Cut” 
The Panel Cut groups together three separate joints: 

• Miter Cut: Saw cut to join two panels along the bisector of their angle, thus avoiding 
the need for an edgeband on their end. 

 
Example of a "Miter cut” 

 

Use body to 
compute 

instead of box 

  Unchecked:  Cut the tenon panel to 
match the face of the mortise panel. 
 

 Checked:  Cut the tenon panel along 
the body of the mortise panel. 

 
 



 

 
 

15  

SWOOD Design – Panel Joint 

• One cover two: Cuts the panel whose plane has been selected second. 

  
Example of "One cover two” 

• Two cover one: Cuts the panel whose plane was selected first. 

 
Example of "Two cover one » 

The "Panel Cut" can be defined by the following parameters: 

Icon Name Effect Image 

 Type 

“Miter Cut”: Cuts the panels along the 
bisector of the angle of the two planes. 
 

“One cover two”:  Cuts the panel whose 
plane has been selected second. 
 

“Two cover one”:  Cuts the panel whose 
plane was selected first. 

 
 

 
 

 

 
Reverse the 

direction 
Reverse the position of the joint between 
the two panels. 
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SWOOD Design – Panel Joint 

 

2. Interface 

a. Creating Panel Joints 

In order to create Panel Joints, you must first open a  SolidWorks assembly, then there are 
several ways to create Panel Joints: 

i. From the menu bar 
To create Panel Joints from the menu bar, go to: 

Tools → SWOOD Design → Panel Joint 

This gives you access to all Panel Joints. 

 

ii. From the CommandManager 
SWOOD Design's Command Manager can be integrated with a Flyout toolbar containing the 
various commands for creating Panel Joints. 

 
Internal 

opening* 

*Only for "Miter Cut" type. 
 
Size of the corner opening between the two 
panels. 

 

 
Do not cut the 
covering part* 

* Only for "One cover two" and "Two cover 
one" types. 
 
Allows to let the covering part run instead 
of cutting it off at the end of the other 
panel. 
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SWOOD Design – Panel Joint 

To do this, you need to: 
1. Right-click on the SWOOD Design CommandManager. 
2. Click on “Customize…”. 

 

3. Go to the “Commands” tab. 

 

4. In the list of toolbars, click on "Flyout Toolbars" (the second one in the list). 

 

5. In the Buttons section, find the "Panel Joint" command. 

 

6. Drag and drop the command into the CommandManager. 

 

7. Clicking on this Flyout toolbar gives access to all Panel Joints. 
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SWOOD Design – Panel Joint 

 

b. Plane selection 
Once the Panel Joint has been selected, a PropertyManager appears, named after the Panel 
Joint. 
The first parameter section is the plane selection section. In this section, there are two planes 
to select, which must be the top or bottom face of the panels. 

 

 

 It is possible to invert the plane selection, using the invert button , for example to 
switch from the top face to the bottom face. 

c. Visualization in the Graphics Area 
Once the planes have been selected, a preview of the Panel Joint is shown in the Graphics 
Area. 
The blue preview shows the joint for the first panel selected. 
The pink preview shows the joint for the second panel selected. 
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SWOOD Design – Panel Joint 

 

Some joints have arrows to indicate the direction of the joint: 

i. The  “Mortise and Tenon” 
For the "Mortise and Tenon" joint, the viewing arrow is used to show the direction of the tenon, 
towards the inside of the panel. 

  
Display arrow for viewing "Mortise and tenon" joint 

ii. The  “Panel Cut” 
For the "Panel Cut" joint, two arrows are provided to show the cutting direction for all three 
types of cut. 

 
Display arrows for viewing "Miter cut" type 
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SWOOD Design – Panel Joint 

 
Display arrows for "One covers two" and "Two covers one" types 

d. Parent and child functions 
Once the Panel Joint assembly has been created and the PropertyManager validated, 
several SolidWorks functions are created in the FeatureManager Design Tree: 

i. Assembly level 

At SolidWorks  assembly level, Panel Joint functions are located at the very bottom of the 
FeatureManager Design Tree. 

 
When you edit this function, you'll find all the Panel Joint parameters previously presented. 

ii. Part level 

At SolidWorks  part level, Panel Joint functions are located at the very bottom of the 
FeatureManager design tree. 

 
When editing this function, you can select the "Action body" or "Action bodies". This allows 
you to define which body(ies) will be used as a reference when applying the Panel Joint.  
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SWOOD Design – Panel Joint 

II. Explanatory video 
To get a better idea of how to use this feature, take a look at the following video: 

Panel Joint 

https://youtu.be/lFf-g_YXvR0
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SWOOD Design – SWOODBox parameters on external panels 

SWOOD Design - SWOODBox parameters on 
external panels  

With this SWOOD Design update, users now benefit from an advanced feature that 
dynamically adjusts the behavior of the SWOODBox using the dimensions of the surrounding 
panels. This technical advance opens up new possibilities for customization and efficiency, 
enabling precise, automated adaptation of your wood projects. Thanks to this intelligent 
integration, designing wood structures and elements becomes more intuitive, faster and 
less error-prone, taking design automation to the next level. 

 
Example of a project where the thickness of the frame panel is used to position the top 

screws of the SWOODBox. 

I. How to use 
To access these dimensions on the context outside the SWOODBox, you need to edit a 
SWOODBox. To do this, you need to: 

• Go to the SWOOD library . 

• Go to the SWOODBox library . 
• Right-click on a SWOODBox, then click on "Edit”. 

 
• Once the assembly is open, click on the "SWOODBox" PropertyManager. 

• Open script window  
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SWOOD Design – SWOODBox parameters on external panels 

 

In the list of SWOODBox  context variables, there are: 
- 6 parameters for outer panel thicknesses: 

Panel Parameter’s name Alias 

Back 
 

Back thickness SBBKT 

Bottom 

 

Bottom thickness SBBTT 

Front 
 

Front thickness SBFT 

Left 
 

Left thickness SBLT 

Right 
 

Right thickness SBRT 
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SWOOD Design – SWOODBox parameters on external panels 

 
- 6 box offset parameters: 

 

Top 

 

Top thickness SBTT 

Offset Parameter’s name Alias 

Back 
offset 

 
Back gap SBBKO 

Bottom 
offset 

 

Bottom gap SBBTO 

Front 
offset 

 
Front gap SBFO 

Left offset 
 

Left gap SBLO 

Right 
offset 

 
Right gap SBRO 

Left offset Right offset 

Front offset Back offset 

Bottom offset Top offset 

Left face 

Right face 

Front face 

Back face 

Bottom face 

Top face 

Width 

Depth 

Height 
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SWOOD Design – SWOODBox parameters on external panels 

 

 Warning: These 12 context variables are read-only, meaning that they can only be read 
and not controlled via the script. 
 

II. Explanatory video 
To get a better idea of how to use this feature, take a look at the following video: 

SWOODBox parameters on external panels 

 

Top offset 

 

Top gap SBTO 

https://youtu.be/OR-huHRnSAg
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SWOOD Design - SWOODBox origin offset 
SWOOD Design version 2024 introduces a new feature that enhances design capabilities: 
the three-dimensional offset of a SWOODBox along the X, Y and Z axes. Thanks to the 
introduction of new parameters, users can now precisely adjust the position of a SWOODBox 
in relation to its insertion volume, without resorting to offset planes. This innovation opens 
the door to the creation of more complex, customized SWOODBox configurations, simplifying 
the design process and offering greater flexibility in the spatial adjustment of your project 
elements. 

 
Example of SWOODBox origin offset in X, Y and Z 

I. How to use 
1. Access to the parameter 

To use SWOODBox's original offset, it is necessary first to: 

• Go to the SWOOD library . 

• Go to the SWOODBox library . 
• Right-click on a SWOODBox, then click on "Edit". 
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SWOOD Design – SWOODBox origin offset 

 

• Go to the SWOODBox PropertyManager . 
• Open the script window . 

Among the SWOODBox "  Object" parameters is the new " Origin offset" parameter, alias 
"ORIGINOFFSET". 

2. Use of the parameter 
Afin d’appliquer des décalages à l’origine selon les axes X, Y, ou Z de la SWOODBox, il faut 
écrire le script suivant : 

 

Script Effect 

ORIGINOFFSET.X = 100 SWOODBox X-axis origin offset of 100mm 

ORIGINOFFSET.Y = 100 SWOODBox Y-axis origin offset of 100mm 

ORIGINOFFSET.Z = 100 SWOODBox Z-axis origin offset of 100mm 
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SWOOD Design – Save File by Drag&Drop 
This new SWOOD Design feature makes it easy to drag and drop a 3D model opened in 
SOLIDWORKS, directly into the SWOOD Design library. It automatically saves new designs, 
creates copies of existing designs and adds shortcuts, making file management quick and 
easy. 

 
Example of file saving using drag & drop 

 

I. How to use 
1. Drag & drop 

The saving action takes place as follows: 
1. Click on the name of the part or assembly in the FeatureManager Design Tree. 
2. Hold click and drag cursor to target SWOOD Design library. 
3. Release the item in a folder in the target SWOOD Design library. 

2. Use cases 
This feature can be used in three distinct situations: 

• If the SolidWorks file is not saved on the computer, drag & drop will save the file in the 
SWOOD Design library. 

• If the SolidWorks file is already saved on the computer, drag & drop will copy the file 
to the SWOOD Design library. 

• If the SolidWorks file is already saved on the computer, drag & drop combined with 
the "SHIFT" key will create a link in the SWOOD Design library to the original file. 

The following table summarizes the use cases for the new feature: 
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SWOOD Design – Save File by Drag&Drop 

 

Each case has the following specificities: 

e. New file  
If you wish to save a new file that has not yet been saved on the computer, and the file type 
can be saved in the library, a save window will open at the location selected at the time of 
deposit. 

In this window, you can: 
• Specify file name and save. 

In this case, the file will be saved in the location selected at the time of deposit. 
Change the save location, specify a file name and save. 
In this case, the file will be saved in the new location. 

 If the new location is not in a library folder, the directory of the saved file is added to the 
library. 

f. Copy  
If the file is already saved on the computer, drag & drop creates a copy of the current file in 
the location selected at the time of deposit. 

 The file must be saved before creating the copy. 

 Copied file does not open automatically. 

g. Link  
If the SHIFT key is held down during deposit, a link to the file directory is created in the library. 

 If the link already exists in the library, the node corresponding to the moved document 
is displayed in the tree. 

Case 
Already 
saved? 

Pressed key Consequence 

New file 

 

No Ø 
The file will be saved in the SWOOD Design 

library. 

Copy 

 

Yes Ø 
A copy of the file will be saved in the 

SWOOD Design library. 

Link 

 

Yes   
SHIFT 

A link will be created in the SWOOD Design 
library to the existing file. 
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SWOOD Design – Save File by Drag&Drop 

 

3. Restrictions 
The drag&drop saving feature observes a few restrictions between SolidWorks file types and 
SWOOD Design libraries: 

• Parts can only be saved in the panel library. 
• Assemblies can only be saved in the Frame library or the SWOODBox library. 
• Drawings cannot be saved in any SWOOD Design library. 

The following diagram summarizes these restrictions: 

 

 

SolidWorks 
file type 

Panels Library 

Frames Library 

SWOODBox Library 

Part 

Assembly 

Drawing 

SWOOD Design Library 

Impossible Drag&drop 
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SWOOD Design – Display of SWOOD Center 
model parameters 

A new feature in SWOOD Design 2024 concerns the editing of SWOOD Center models. As with 
SWOODBoxes in 2023, a set of tools for displaying model parameters will facilitate, secure 
and accelerate model creation. 

 
SWOOD Center model parameters interface 

 

I. How to use 
To view the new SWOOD Center model parameters, simply create or modify an existing 
SWOOD Center model. 

1.  Search bar 

To access the search bar, simply click on the  magnifying glass icon in the parameter’s 
toolbar. It will open the search bar above. 

 
• Search is not case-sensitive. For example, a search for "Oo" may display words with 

"oo" or "OO". 
• Search is inclusive. For example, a search for "oo" might return "Groove". 
• Search is active in variable names, descriptions, aliases and categories. 

 

2. Filters 
It is possible to display certain parameters according to some of their properties. 
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SWOOD Design – Display of SWOOD Center model parameters 

a. Parameter types 

Filters can be applied to the following parameters:  Distance,  Integer,  Angle,  

Boolean,  String,  Decimal and  Object. 

b. Exposure 

If the "Exposed" filter is  unchecked, only exposed parameters are shown in the list. 

3. Folder organization 
Parameters with a category are now placed in a folder with the name of the category in the 
list of parameters. 

  

It is possible to assign a category to a parameter simply by dragging it into a folder. 

 

This folder organization can be deactivated by clicking on the "  Show/Hide Repository" 
filter.  

 
Folder layout    Classic layout 

If folders are visible, you can open all folders at once by clicking on the "  Open/Close 
Repository" filter. 
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Closed categories             Open categories
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SWOOD Design – Search for files in libraries 
With SWOOD 2024, there is a significant improvement in the search algorithm for SWOOD 
Design libraries. This improvement is particularly relevant for companies with SWOOD 
Design libraries containing many elements. 

 

Indeed, with this new algorithm, the search takes 4x less time to complete. 

From now on, results will be displayed as a list of items matching the search, rather than in 
a sub-folder structure. 

I. How it works 

 

  

Old search algorithm New SWOOD 2024 search algorithm 
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II. Explanatory video 
To get a better idea of how to use this feature, take a look at the following video:  

Search for files in libraries 

 

 

 

https://youtu.be/GFKYwst9H8I
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SWOOD Design – Clickable links in SWOODBox 
messages 

This new feature has been created to allow users to click on hyperlinks when they appear in 
SWOODBox messages. This can be particularly useful for directing the user to the catalog of 
a hardware supplier used in the SWOODBox. 

 
Example of SWOODBox editing with a clickable link in a SWOODBox message 

I. How to use 
In order to create clickable links in SWOODBox messages, you have to: 

• Go to the SWOOD library . 

• Go to the SWOODBox library . 
• Right-click on a SWOODBox, then click on "Edit". 

 
• Once the assembly is open, click on the "SWOODBox" PropertyManager. 

• Open the script window  
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SWOOD Design – Clickable links in SWOODBox messages 

 

In your SWOODBox script, you can include a message containing an URL. 

 

This link can be clicked directly in the SWOODBox "Test Mode" and also when editing the 
SWOODBox once it has been inserted. 
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SWOOD Design - New mathematical script 
functions 

SWOOD Design 2024 integrates four new scripting functions that can be very useful for 
SWOODBox, Connectors and SWOOD Center models. 
The Min(A, B) function compares the two values A and B and returns the minimum. 
The Max(A, B) function compares two values, A and B, and returns the maximum. 
The Floor(A, C) function is used to round down A to C decimal places. 
The Ceil(B, C) function is used to round up B to C decimal places. 

  
Script example using the new mathematical functions 

I. How to use 
In order to use the new mathematical script functions, you need to edit the script: 

•  Of a SWOODBox. 

•  Of a connector. 

•  Of a SWOOD Center model. 

1. Minimum and Maximum 
The minimum (Min) and maximum (Max) functions compare two numbers and give either 
the minimum or the maximum between these two values. 

 Warning: The minimum and maximum functions can be used to compare only two 
numerical parameters. 

 Tip: To compare more than just two numbers in a minimum or maximum function, you 
can interlock the functions. For example, to find out the minimum between the numerical 
parameters A, B and C, simply write: 

Result = Min(Min(A, B), C) 
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2. Top and bottom rounding 
The "Floor" and "Ceil" rounding functions are used to round a numerical parameter to a 
certain number of decimal places. 

For example, if you take the decimal number "1.2345" and want to round it to three decimal 
places: 

The formula Floor(1,2345, 3) returns 1,234 
The formula Ceil(1,2345, 3) returns 1,235 
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SWOOD CAM – New 3D Finishing (BETA) 
SWOOD CAM version 2024 revolutionizes its 3D machining management with the 
introduction of its new 3D Finishing machining. This major advance, features a significant 
improvement in algorithmic stability, surpassing the performance of previous finishing 
operations. It is complemented by a completely redesigned operation editing interface for 
maximum intuitiveness, offering users unprecedented flexibility thanks to an expanded 
range of selections and options. What's more, this feature eliminates the need to create 
stitched surfaces thanks to advanced 3D object recognition, considerably simplifying the 
machining process. This innovation represents a giant step forward in the optimization and 
customization of 3D machining, guaranteeing high-quality finishes with enhanced 
efficiency and ease of use. 

 
New 3D Finishing interface 

I. How to use 
To use the new 3D finishing, you no longer need to create  Knit surfaces on the surfaces 
you wish to machine. From now on, no selection is required to create a new 3D finishing. 

1. Access to the new 3D finishing 
To access the new 3D finishing interface, simply go to the SolidWorks menu bar: 

Tools → SWOOD CAM →  3D Finishing 

2. Interface 
The new 3D finishing window is divided into 6 sections: 



 

 
 

41  

SWOOD CAM – New 3D Finishing (BETA) 

 

a. Toolbar 
The toolbar of the new 3D finishing window contains the following commands: 

Icon Command name Description 

 Technology Parameters 

Defines the machining and technology parameters of 
the operation. These include the operation name as it 

will appear in the milling phase, tool selection and 
cutting parameters. It is also possible to choose the 

operation's technology parameters and manage the Z 
axis movements. 

 Face Selection 

Selects the faces to be machined and the faces to 
protect. By default, the entire 3D model is selected. It 

is also possible to select only some of the model's 
faces. 

 Constraints 

Defines operation reference planes and their offsets, 
such as Z security, Z approach, maximum and 

minimum machining altitude planes. 

Use sketches to define specific areas for machining, 
inclusive or exclusive. 

 Slicing Parameters Defines parameters for slicing the operation, such as 
slicing direction. Also defines slice adaptability to the 

Graphics Area 

Status bar 

Toolbar 

Validation bar 

PropertyManager 

Rebuild bar 
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SWOOD CAM – New 3D Finishing (BETA) 

 
When a command is clicked, the PropertyManager adapts to the command and presents 
the parameters of the section. 

b. Validation bar 
The validation bar contains the following commands: 

 

c. PropertyManager 
The parameters displayed in the PropertyManager depend on the section selected in the 
toolbar. 

d. Rebuild bar 
The rebuild bar is a visual aid to help you see how far along you are in rebuilding the 
operation, since modifying parameters alone is not enough to update the operation. 

A green rebuild bar means that the model has been successfully rebuilt according to the 
latest parameter modifications. 

curvature of the 3D model. In this section, it is also 
possible to define pass spacing. 

 Finishing Parameters 
Defines the operation's finishing parameters, such as 

CNC type or selection of transition type between 
passes. 

 Rebuild 
Recalculate operation according to last parameter 

modification. 

Icon Command name Description 

 Operation Validation 
Validates parameters and creates a machining 

operation. 

 Operation Cancel 

Does not take machining parameter modifications 
into account. If this is the first edition of the 

operation, it is not created; if it is an edition of an 
existing operation, the parameter modification will 

not be taken into account. 

 Previous Section Returns to previous section. 

 Next Section Skip to next section. 
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SWOOD CAM – New 3D Finishing (BETA) 

A blue rebuild bar means that the model has not yet been rebuilt. 

e. Status bar 
The status bar displays messages appropriate to the state of the model and its rebuilding. 

f. Graphics Area 
The graphics area displays and interacts with the 3D model, especially when selecting 
surfaces to be machined, protected or excluded. 

The 3D model is displayed without texture, with its origins defined in the machining phase. 

 
The Graphics Area features a Heads-up View Toolbar, with the following commands: 

  

Configuration Image 

Sans sélection 

 

Surfaces usinées 
(en bleu ciel) 

 

Surfaces protégées 
(en jaune) 
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II. Explanatory video 
To get a better idea of how to use this feature, take a look at the following video:  

New 3D Finishing (BETA) 

 

Icon Command name Description 

 Zoom to fit Zooms to all visible items. 

 View Selector 
Choose between standard and non-standard 

display orientations. 

 Display Style 

Displays a flyout where you can change the display 
style for the active view: 

 Shaded With Edges,  Shaded,  Hidden Lines 

Removed,   Hidden Lines Visible,  Wireframe, 
Mesh with fins, Fins. 

 Hide / Show All Types 

Controls the visibility of all types: 

 Part,  OP0,  Selected Faces,  Reference 

Planes,  Trajectory, Stock,  Slicing,  Protected 

Faces,  Volumic Constraints. 

https://youtu.be/65fBpNTf5fY
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SWOOD CAM – Edgeband Encoder 
The latest version of SWOOD CAM introduces a feature that enables automatic 
edgeband application directly from the machine, thanks to sophisticated integration in the 
program code. Designed specifically to work with B-SOLID and WOODWOP post-processors 
dedicated to this task, this advance offers a solution for automating and simplifying the 
edgeband application process. This enhancement promises not only to increase 
manufacturing efficiency, but also to optimize finishing quality. To take full advantage of this 
feature and transform your production, we recommend that you consult your SWOOD 
reseller. 

 
Edgeband encoder window interface 

I. How to use 

 Warning: Edgeband encoder feature can only be used with B-SOLID or WOODWOP 
post-processors specifically configured for this purpose. 

 Warning: To use the edgeband encoder feature, SWOOD CAM and SWOOD Design must 
be activated. 

1. Edgeband encoding application 
To apply an edgeband encoding to a SWOOD panel, several steps are required: 

1. Open a  SWOOD panel in SolidWorks. 

2. Apply one or more  SWOOD edgebands. 

3. Create a  milling phase with a compatible post-processor and define  
origins. 

4. Click on the "Edgebands" command, available from the SolidWorks menu bar: 

Tools → SWOOD CAM →  Edgebands 
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Two new elements can be seen in the milling phase: 

•  Inserting code into the program. 
• A new machining called "Edgebands” 

  

2. Main window 

 There is no need to edit edgebands for every part. Once they've been set up correctly, 
there's no need to modify them for future projects. 

To access the main edgeband editing window, simply right-click and select "Edit", or double-
click on one of the two "edgeband" commands in the milling phase. 

The main edgeband editing window is divided into 3 sections: 

 

a. Toolbar 

The toolbar of the main edgeband editing window contains just one command: the  
edgeband encoding parameters.  

b. Parameters 
The edgeband parameters in this section depend on the edgeband applied to the panel. 

Graphics Area 

Toolbar 

Parameters 
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The first parameter in the list is always "  Positioning". This parameter allows you to choose 
whether you wish to encode edgebands before or after machining. 

i.  Edgebands parameters 

• The "  Rank" parameter defines the position of the edgeband in relation to the 
others. The order of the edgebands in the list displays the most "covered" edgebands 
first, followed by the "covering" edgebands. 

• The "  Done before CNC" parameter is used to exclude this edgeband from 
encoding, as it was done before the CNC. 

 Warning: Excluding a "covering" edgeband will exclude all covered edgebands. 

Tip: The "Done before CNC" parameter can be set directly in the edgebands 
library, so that it is automatically checked each time it is used. 

 

• The other parameters are informative and cannot be modified, as they have already 
been defined in the Edgebands Library. 

ii. Edgeband  finishing parameters (left or right) 
Left and right edgeband finishing parameters are informative and cannot be modified, as 
they have already been defined in the Edgebands Library. 

c. Graphics Area 
The Graphics Area shows the panel in top view from its program origin. 

Edgebands are shown thicker, so that they can be easily located and overlaps clearly seen. 

 The Graphics Area can be zoomed in and out to highlight certain areas of the panel. 

When an edgeband is clicked in the Graphics Area, its row number turns red and its 
edgeband parameters are highlighted in the Parameters section. 
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3. Edgeband encoding parameters 
To access the edgeband encoding parameters, click on the single toolbar command in the 
main edgeband editing window. 

a. Global settings (B-SOLID and WOODWOP) 
The global settings include the following parameters: 

 

 

Icon Parameter name Description 

Configuration 

 
Automatic order of 
edgeband gluing 

Allows the software to automatically reorder 
edgebands to optimize application and minimize tool 

changes. 

 Use edgeband reference 
Uses the edgeband reference in the encoding, as 

defined in the edgeband library. 

 Default insertion location 
Defines whether the code is inserted at the 

beginning or at the end. 

Graphic display 

 Enable real thickness Displays edgebands at their actual thickness. 

 Zoom speed 
Defines zoom speed. The higher the value, the faster 

the zoom. 
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b. WOODWOP settings 

Icon Parameter name Description 

Edgeband encoder parameters 

 Only on right angle 
Separates edgeband  trimming (Bündigfräsen) into 

several operations when the angle of intersection of 
two edgebands is different than 90°. 

 Enable blowing Activates  blowing operation (Abblasen) 

 
Combine saw round 

corner 

Allows the same aggregate to be used for corner 
finishing. Also modifies the order of operations to 

optimize machine movements. 

 Enable stop 
Adds a stop between edgeband  trimming and 

 gluing 

Macro 

 Right contouring 
Adds a specific macro for right contouring all around 

the part. 

 Blow Adds a specific macro for blowing. 

 Saw Adds a specific macro for the sawing operation. 

 Right finishing 
Adds a specific macro for the right finishing 

operation, when performed by contouring with a 
milling tool and on the right-hand side. 

 Left finishing 
Adds a specific macro for the left finishing operation, 

when performed by contouring with a milling tool 
and on the left-hand side. 

 Round corner 
Adds a specific macro for rounded corners when 

made with the aggregate. 

 Stop Adds a specific macro for the stop. 
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c. Edgebands parameters (only for WOODWOP) 
To edit the edgeband parameters, click on the button and another window will appear 
showing all the edgebands available in the SWOOD Design Edgebands library. 

i. Editing an edgeband 
Selecting an edgeband from the library on the left of the window brings up the following 
parameters: 

 Stock Adds a specific macro for stock. 

Variables names 

 Edgeband thickness 

Defines the name of the edgeband thickness 
parameter in the encoding. 

 Warning: the name must not contain any 
special characters. 

Before and after CNC 

 Enable 

Allows to specify edgebands placed before or after 
CNC. If this option is checked, the module will adjust 

the operation to avoid splintering edgebands. 

If this box is checked, a window appears during 
encoding, asking which edgebands are placed on 
the CNC. Each edgeband is identified by a number. 

 Left contouring Adds a specific macro for partial left contouring. 

 Split distance Length of partial contouring on the left. 

 Enable drilling method 
If left contouring is not possible, it can be replaced 

by drilling to avoid splintering the edgeband. 

 Tool ID 
WOODWOP tool number for edgeband drilling. Keep 

0 if drilling is managed by diameter only. 

 Diameter 
Diameter of hole to be created. This parameter is 

mandatory. It must be entered to place the hole in 
WOODWOP. 
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Icon Parameter name Description 

 Use extended properties 
Allows to assign the parameters already defined in a 
template to this edgeband, instead of having to enter 

them all several times. 

 Name 

If the previous parameter is unchecked  : 
Displays the edgeband name, as defined in the 

Edgebands library. 

If the previous parameter is checked  : 
Selects the template to be used. 

Gluing 

 Gluing type 

Gluing type in WOODWOP 
Easy edge Edge Power edge 

   
 

 Macro Adds a specific gluing macro. 

Saw 

 Offset angle C   Defines a global rotation angle for the saw. 

 Offset when finishing   Distance of saw line from cut defined when 
finish is "None". 

 
Offset angle when 

finishing 

  Defines the saw line angle in relation to the 
defined cut when finishing is set to "None". This value 

is the sum of offset angle C. 

 
Enable before round 

finishing 
Allows to make a rounding cut before round 

finishing. 

 Offset before finishing 
Defines the distance of the saw line from the defined 

cut when the finish is a rounded corner. 
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Offset angle before 

finishing 

Angle of the saw line in relation to the defined cut 
when the finish is a rounded angle. This value is the 

sum of the offset angle C. 

 Enable cut before flush 
When trimming is the finishing operation, this 

parameter defines the order between trimming and 
flush trimming. 

Round corner 

 
Enable round corner 

aggregate 
When the finishing is a rounded corner, it is possible 

to use the aggregate or simply a milling cutter. 

Flush trimming 

 Macro Adds a specific flush trimming macro. 

 Enable anticipation 

When one edgeband overlaps another with a 
rounded corner, anticipation can be used to reduce 
the risk of edgeband damage. It allows to modify the 

C value before the corner and to adjust the feed 
speed while the corner is being flush trimmed. 

 
Enable techno 

parameters files 
Uses WOODWOP or SWOOD model technologies. 

 Techno parameter files 
Allows to modify and save a "Technologiemakro" in 

WOODWOP as a .nca file. 

 Anticipation distance 
Sets the distance from the anticipation starting point 

to the corner. 

 Anticipation Speed 
Defines the speed of the aggregate at the 

anticipation starting point. 

 Anticipation offset Sets the angle of the anticipation offset. 

Scraping (1 ou 2) 
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Scraping 1 operations are performed counterclockwise (the tool is on the right). It can also 
be used in a clockwise direction by activating scraping 2 and checking the Clockwise 
parameter. 

ii. Template management 
To avoid modifying the parameters of each edgeband in the edgeband library, it is possible 
to create templates that can be applied to several edgebands. 

To create a template, simply click on the "  New" button in the window's toolbar. 

To delete a template, simply click on the "  Delete" button in the window's toolbar. 

 Enable scraping 
Adds the scraping operation (Bündigfräsen) at the 

end of the program (after flush trimming). 

 Macro Sets the scraping macro. 

 Enable Anticipation 

Allows to change the feed speed during corner 
scraping. When one edgeband overlaps another 

with a rounded corner, anticipation can be used to 
reduce the risk of edgeband damage. 

The principle is very similar to that of flush trimming, 
except that the "Technologiemakro" does not include 
a C modification. It only manages the F value (Feed 

rate). It only manages the F value (Feed rate). 

 
Utiliser une macro 

d’anticipation 
Comme pour l'affleurage, utilise les technologies du 

modèle WOODWOP ou SWOOD. 

 Techno parameter files 
Allows to modify and save a "Technologiemakro" in 

WOODWOP as a .nca file. 

 Anticipation distance 
Sets the distance from the anticipation starting point 

to the corner. 

 Anticipation speed 
Defines the speed of the aggregate at the 

anticipation starting point. 
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SWOOD CAM – Angle Finishing 
With SWOOD 2024, a new operation has been developed to enable concave corners to be 

completely machined using a conical milling cutter. This operation is called "  Angle 
Finishing". 

To be effective, this operation is generally used after a "Resume pocket angles" or "Resume 
angles using radius compensation" operation. 

 
Finishing a pocket corner 

I. How to use 
1. Operation application 

The operation can be applied to the following machining: 

 

Icon Machining name 

 Profile 

 Closed sketch 

 Open sketch 

 Auto pocket 

 Closed pocket 

 Open pocket 
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2. Operation creation 
Once you have chosen a machining and a compatible tool (Chamfering cutter or Engraving 

cutter), simply select the  "Angle finishing" operation and "add" it. 

 
 

3. Operation parameters 

The "  Angle finishing " operation contains the following specific parameters: 

 
Side edge length: Size at which machining starts; depends on the diameter of previous tools. 
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a. Transitions 

 

b. Mid-angle trajectories 

 

 

Diagonal transition Zigzag transition 

  

Straight transition between two corners to 
be machined. 

Zigzag transition between two corners to be 
machined. 

  

Without mid-angle trajectory With mid-angle trajectory 

  

WITHOUT machining on the bisector of the 
angle of each corner to be machined. 

WITH machining on the bisector of the angle 
of each corner to be machined. 
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4. Results 
With this new feature, pockets with internal corners can now be completely machined. 

Without angle finishing With angle finishing 
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SWOOD CAM - Corner Notching 
A new machining operation has been integrated into SWOOD CAM 2024, the "  Corner 
Notching". This operation is the cousin of the Angle Finishing operation, but this time it is used 
to machine the corners of through-hole profiles, using an angled tool. This operation can be 
performed after a simple "Contouring" operation. 

 
Squaring an inside corner of a through profile 

 

I. How to use 
1. Operation application 

The operation can be applied to the following machinings: 

 

2. Operation creation 

Once a machining entity and a  saw-type tool (preferably on an angled aggregate) has 

been chosen, simply select the "  Corner Notching" operation and "add" it. 

Icon Machining name 

 Profile 

 Closed sketch 
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3. Operation parameters 

The "  Corner Notching" operation contains the following specific parameters: 

a. Automatic distance to angle activated 

By activating this  button, the operation uses the diameter of the previous tool to 
calculate the distances to the corner, left and right. 

b. Automatic distance to angle deactivated 
If the button is disabled, the left and right corner distances must be entered manually, using 
the "Distance to angle on left side" and "Right corner distance" parameters. 
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4. Results 
With this new feature, it is now possible to completely machine profiles with internal angles. 

 

Without Corner Notching With Corner Notching 
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SWOOD CAM – Clamex with milling tool 
For several versions of SWOOD CAM, it has been possible to create machining operations 
with a blade, using Clamex connectors. With SWOOD CAM 2024, it is now possible to create 
these machining operations with a milling tool, whether in 3-axis or 5-axis mode. 

 
Example of Clamex machining with milling tool 

I. How to use 
1. Operation application 

The "  Clamex with milling tool" operation can be applied to a manual or automatic  
Clamex machining. 

2. Operation creation 

Simply select the "  Clamex with milling tool" operation and "add" it. 
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3. Operation parameters 

The "  Clamex with milling tool" operation contains the following specific parameters: 

a. Lead In & Out distance 

 

Arc length of machining outside Clamex. 

 

b. 3 / 5 axis milling 
The machining button is used to switch between 3-axis and 5-axis machining. 

3 axis milling 5 axis milling 

  

Angles B and C remain at zero during 
machining 

Angles B and C change to keep the tool axis 
perpendicular to the surface to be machined 
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SWOOD CAM - New automatic orientation 
strategies 

When creating the origins of a part, it is possible to select the positioning method based on 

 automatic recognition (especially for users who do not have SWOOD Design). SWOOD 
CAM 2024 includes groove recognition options, enabling both the definition of the groove to 
be recognized for positioning and the orientation of the groove. This last option is particularly 
relevant for companies using vertical machines, or machines processing all six sides of 
parts. 

 
Setting automatic positioning rules 

I. How to use 
1. Creation of automatic positioning rules 

To create automatic positioning rules, it is necessary to: 

•  Open a SWOOD panel. 

•  Créer une phase d’usinage. 

• Click on the "  Origins" toolbar button. 

• Select "  Based on automatic recognition" mode. 

• In "Strategy", click on the  edit button.  
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•  Create a new configuration.  

• In "  X choice", select "Longest groove". 

2. Groove orientation parameter 

The following options are available for "  Groove orientation”: 

 

Downwards Upwards 

The longest groove is positioned at the 
bottom of the panel in relation to its origin 

The longest groove is positioned at the top of 
the panel in relation to its origin 
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SWOOD CAM - Simplified access to "Tools 
synchronization" and "CAM copy" 

SWOOD CAM offers additional tools to make life easier for certain users, such as the "Tools 
synchronization" tool and the "CAM copy" tool. SWOOD CAM 2024 provides simplified access 
to these tools, directly in the software interface. 

 
Direct access to tool commands 

I. Tools Synchronization 
This utility helps to recreate a machine's tool library in the SWOOD CAM tool library. 

1. Open "Tools synchronization” 
From SWOOD 2024, this utility can be opened from the SolidWorks menu bar: 

Tools → SWOOD CAM → Utility → Tools Synchronization 

II. CAM copy 
This utility is used to copy machining operations from a part or assembly into a file or set of 
files in a single action. 

1. Open “CAM copy” 
From SWOOD 2024, this utility can be opened from the SolidWorks menu bar: 

Tools → SWOOD CAM → Utility → CAM copy 
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SWOOD CAM – Report option if no machining to 
be encoded 

Since SWOOD 2024, it is possible to create a customizable event in the report when there is 
no machining to code. This can be particularly useful for companies that automate SWOOD 
CAM, using part or assembly models that already have automatic machining. This new 
feature will warn them at report time if certain parts do not need to be machined. 

 
Program initialization window with warning selection 

I. How to use 
To select the warning to be displayed when a program is encoded in the report but does not 
contain any machining to be coded, it is necessary to: 

• Open a  part or an  assembly. 

• Create a new  milling phase. 

• In the "Report Options" section, there is the "  No machining to encode alert" 
parameter. 

• Select "None" or "Error" option. 

II. Result 
According to one or other option, with a program that has no machining to code, the results 
will be as follows: 

1. If None is checked 

If the "  No machining to encode alert" report option is set to "None". 

 
In this case, when a report is generated, there are no errors. Neither in the general variables, 
nor in the part program. 
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2. If Error is checked 

If the "  No machining to encode alert" report option is set to "Error". 

 

In this case, when a report is generated, an error occurs. In the general parameters, and in 
the part program. 
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SWOOD Nesting – Ignore grain direction 
This new feature allows you to ignore the grain direction if this improves nesting 
optimization. This feature can be used for parts that will not be visible, such as hidden backs 
or side panels. 

 
Example of a Nesting project where the grain direction has been ignored 

I. How to use 
1. Manual parameter 

The first way to apply the "Ignore grain direction" parameter is to check it in the parameters 
of each part to be nested. To do this, it is necessary to: 

•  Creating a Nesting project (Tools → SWOOD CAM →  Nesting). 

•  Inserting parts to be nested in the project. 

•  Go to the "Parts for nesting" folder. 

•  Select the part(s) to be nested. 

•  At the bottom of the Nesting parameters, check the "Ignore grain direction" 
parameter. 

 
•  Rebuild the Nesting project. 
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2. Automatic parameter 
It is possible to make the process a little more automatic by using custom properties for 
SolidWorks parts. 

To do this, it is necessary to: 

•  Open the panel where you want to ignore the grain. 

•  Open "File properties". 
• Click on the "Custom" tab, or the "Configuration Specific" tab. 
• Add a new property: 

 

 

Once this property has been set, the next time Nesting is optimized, the part to be nested 
will be automatically checked. 
 

II. Result  
If the "ignore grain direction" parameter is checked on a part to be nested, then the nesting 
algorithm will no longer take grain direction into account for this part and will optimize part 

orientation only according to general nesting parameters (such as "  Rotation step"). 

   

Name Type Value 

IGNORE_GRAIN_DIRECTION “Text” (or “Yes or no”) Yes (to activate) 
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SWOOD Nesting – Forcing four corners in part 
types 

This new feature has been created to automatically activate the "Four Corners" mode via "

 Part types". This mode places parts differently from normal mode, helping to hold small 
parts securely on the plate during machining. 
 

 
“Four corner" part layout 

I. Parts layout 
The layout of the parts is as follows: 

  

Regular layout Four corner layout 

The parts to be nested are positioned 
starting from the selected corner in 

descending order of size. 

The parts to be nested are positioned 
alternately in the four corners of the plate in 

descending order of size. 
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II. How to use 
In order to force the "Four corner" layout in the "Part types", it is necessary to: 

•  Create a Nesting project (Tools → SWOOD CAM →  Nesting). 

• In the Nesting window toolbar, click on "  Part types". 

• If no part type exists, create a  new part type. 
• In the "Nesting" section, check the "Force four corner" box. 

Once the box is checked, another box appears: "Force four corner on last sheet". 
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SWOOD Nesting – Disable program recalculation 
SWOOD 2024 innovates with a feature designed to further improve nesting efficiency: the 
option to deactivate automatic recalculation of programs when they are created or 
modified. This technical innovation specifically targets the challenges associated with the 
nesting of major components, where recalculation time represents a significant part of the 
process. Secure and reliable, this function ensures that recalculations are only triggered 
during program encoding or report generation, optimizing workflow without compromising 
accuracy. An innovation that promises to transform Nesting management, significantly 
reducing processing times and boosting productivity. 

 

I. How to use 
To deactivate program recalculation, it is necessary to: 

•  Create a Nesting project (Tools → SWOOD CAM →  Nesting). 
• In the Nesting project window, go to the "Machining" section and check the "Disable 

machining rebuild" box. 

From now on, CAM programs will not be recalculated when the Nesting assembly is created. 
They will only be rebuilt under three conditions: 

•  If you manually rebuild the program. 

•  If you encode the program. 

•  If you generate a report. 
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SWOOD Report – System Report 
SWOOD 2024's all-new functionality radically transforms the way professionals interact with 
their data, thanks to the introduction of system reporting. Designed to suit any company 
looking to optimize its processes, this innovation is based on a remarkably intuitive user 
interface accessible from any web browser. What really sets this feature apart is its ability 
to enable unprecedented customization of data and document display. With just a few 
clicks, users can modify the appearance of their reports to better suit their specific needs, 
making workflow not only smoother but also more efficient. This breakthrough illustrates 
SWOOD's commitment to providing solutions that not only improve productivity, but also 
transform the way companies manage and present their critical data. 

 
Example of a page in the system report 

To see a presentation of the system report, you can watch this video. 

To go further in the configuration of the system report, please consult this page: 

 

https://youtu.be/O7_wkw9_HCI
https://www.eficad.com/CRM_ARTICLES/public/report/?
https://www.eficad.com/CRM_ARTICLES/public/report/?
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I. How to use 
1. System report installation 

a. Activation 
To take full advantage of this new system report, you first need to activate the system report. 
To do this, it is necessary to: 

• Open the "  Settings" window in SWOOD Design or SWOOD CAM. 

• In the "Report" section, click on the  system report edit button. 
• Activate “System Report”. 

 

To better understand how to activate the system report, you can watch this video. 

b. System report generation 
As for generating a classic report, go to the menu bar and select: 

Tools → SWOOD Design (or SWOOD CAM) →  Report 

In the report window, expand "    Documents" and open the HTML page "  
SYSTEM_REPORT". 

 
  

https://www.youtube.com/watch?v=XTVPtXNOsP0
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2. System report interface 
The system report page is divided into 4 sections: 

 
• Menu bar (top): Displays the company logo, the name of the current project and, on 

the right, the  parameters. 
• Data category panel (left): Displays data categories on the main view (the choice of 

categories to be displayed is made in the parameters). 
• Export bar (below menu bar): Enables the user to export the data displayed in the 

main view, as a printout or CSV export. 
• Data display: Main data view, depending on the data category selected in the left 

panel. 

a. Parameters 

To access the parameters, click on the  gear on the far right of the menu bar (accessible 
on all pages). Settings have three tabs: 

i. General parameters 
In the general parameters, it is possible to import an existing configuration and set display 
parameters such as language, units of length, etc... 

 

 

 

 

 

 

Menu bar 
Export bar 

Data 
category 

panel 

Data display 
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ii. Data 
In this window, it is possible to choose which data categories will be displayed in the data 
category panel (left). 

On the right-hand side, the available data can be  transferred to the left-hand side, with 
the data categories displayed. Alternatively, you can hide certain data categories with the 

button  to the right. 

The order of data categories can be changed by dragging and dropping, while holding 

down the   six dots. 

These categories will be displayed in the data category panel only if the displayed project 
contains data. 

 

To better understand how to add a new data category to your system report, watch this 
video. 

 

https://www.youtube.com/watch?v=1t1M6w9sDSQ
https://www.youtube.com/watch?v=1t1M6w9sDSQ
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iii. Print settings 
In this window, it is possible to set print parameters, such as header image, specific table 
views, etc… 

 

b. Data categories 
Data categories display project data by type of information. 

i. Permanent categories 
There are 3 categories that are always present, whatever the project data: 

 Project History: This category shows all projects that have been opened previously. 
It is also possible to import a project that has been generated by another PC. To do this, click 
on "Project file" or drag and drop on this section. The file extension to be imported is SWR 
(specific to SWOOD system reports). 

 

 Project: This category displays the current project with project image, report path and 
SolidWorks file path. 
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 Summary: The "Summary" category of data sums up the costs of all types of data, such 
as edgebands, materials, cutting patterns, machining, etc… 

 

ii. Project categories 

Numerous categories can be displayed in the category panel, such as  assemblies,  

panels,  stock,   hardware,   edgebands,  programs, etc… 

It is possible to choose which categories are to be displayed in the panel, and in which order, 
from the "Data" tab of the settings. 

c. Data display 

Except for certain data categories such as  Project,  Cutting Plan and  Summary, all 
data categories are presented in table format. 
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i. Manipulating tables 
Data tables have been created to display the values most relevant to users. These tables 
can therefore be customized. 

The table interface is divided into 3 sections: 

 

• Filter bar 
In this section, you can customize the display of data columns. Several tools are available 
for this purpose (from left to right): 

o Views 
A view is a kind of "snapshot" of a table in a particular state, with its columns and filters. 

You can display a preset view by clicking on the  down arrow and selecting it. 

The following view options are available: 

To better understand how to add a new view to a table, you can watch this video. 

 

Icon Option name Description 

 View settings 
Modify view parameters by adding one or more 

custom columns 

 Save as Saves the display status of the panel in a new view 

 
Add to favorites / Remove 

from favorites 

Adds or removes this view to the data category 
favorites, directly accessible from the data category 

panel 

 Delete Deletes the selected view from the saved views 

Filter bar 

Data columns 

Page management 

https://www.youtube.com/watch?v=tA3YaW43rM8


 

 
 

81  

SWOOD Report – System Report 

o Modify columns 

When you click on the "  Modify columns" button, a panel appears on the right with two 
tabs: 

▪ Sort 
This tab allows you to change the column order by simply dragging and dropping existing 
columns. You can even add an empty column. 

 

To better understand how to manage current columns in a table, watch this video. 

▪ Add/Remove. 
This tab lets you add or remove columns from the current view. In this tab, you can find all 
report parameters, and turn them into a column. 

https://www.youtube.com/watch?v=L1_SaQOTXMg
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To better understand how to add a new column to a table, you can watch this video. 

o Filters 
It is possible to display the contents of columns by filtering according to certain rules. When 

you click on "  Filter", a window opens, offering you to apply filters or groups of filters. 

 
To better understand how to create and apply filters to a table view, watch this video. 

To better understand how to remove a filter from a table view, watch this video. 

 

https://www.youtube.com/watch?v=u2ns3L14DlI
https://www.youtube.com/watch?v=UU92fFfg1KU
https://www.youtube.com/watch?v=tNBDD51jdLc
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o Lines height 

It is possible to adjust the  height of lines in the table display according to 3 different 
heights: compact, medium, or spaced. 

 
To better understand how to adjust the height of the lines in a table, you can watch this 
video. 

o Search bar 
You can easily find a table element using the search bar. This search is not case-sensitive. 
You can enter only part of the word you are looking for. 

• Data columns 
The data columns section displays the selected columns with their respective filters. 

Next to each column name, as you move the cursor closer, a downward arrow appears. By 
clicking on it, several options are available: 

To better understand how to rename a table column, watch this video. 

o Column width adjustment 

Column widths can be adjusted to display data more clearly. Several options are available: 

▪ Manual column adjustment 

Icon Option name Description 

 Ascending sorting 
  Sorts each line of the table from the smallest value to 

the largest. If the row is composed of text, sort in 
alphabetical order. 

 Descending sort 
Sorts each line of the table from the largest value to 
the smallest. If the row is composed of text, sorts in 

reverse alphabetical order. 

 Create filter 

Create a filter that applies only to values of the 
column. 

 Warning:  column filters will not be saved in the 
view. 

 Rename column Allows to rename the column. 

https://www.youtube.com/watch?v=bxNj2OrOrrw
https://www.youtube.com/watch?v=bxNj2OrOrrw
https://www.youtube.com/watch?v=WT92tqNAVKY
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When the mouse cursor is close to the separation between two columns on the column 

header line, the cursor becomes an  adjustment tool. This allows you to enlarge or reduce 
the column width. 

▪ Automatic column adjustment 

When the column width  adjustment tool is visible when double-clicked, the column 
width automatically adjusts to the most suitable width, allowing the text in that column to 
be read at its best. 

▪ Automatic adjustment of all columns 

If you place the mouse cursor to the far right of the column heading line, when you double-
click on the adjustment tool, the width of all table columns is suddenly adjusted to the space 
required for reading the data.  

ii. Favorites management 
As we saw earlier, it is possible to set a view as a favorite. Once a favorite has been created, 
we can see it appear in the data category menu. 

 
Clicking on this favorite directly from the data category menu opens the favorite table in 
read-only mode and displays a menu bar above the table. 

 

Icon Option name Description 

 CSV export Allows you to export table contents in CSV format. 

 Print Allows you to print the contents of the table. 

 Modify the view 
Allows you to edit the table view, adding or deleting 

columns, filters, etc. 

 Remove from favorites Removes the view from the favorites list. 
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SWOOD Report – Cutting Pattern 
SWOOD 2024 enhances its functionality with a tool from the SWOOD report: the creation of 
a cutting diagram for the panels used, accessible without the need for a SWOOD CAM 
Nesting license. This function is based on advanced panel optimization, using data from the 
material and board library, offering double added value. On the one hand, it provides a 
precise estimate of the number of sheets needed to complete a project, enabling a more 
accurate evaluation of the associated costs. Secondly, it generates a detailed cutting 
diagram, which can be used directly in the workshop for manual sawing of panels. This 
innovation represents a step forward in resource optimization and project planning, 
simplifying the preparation and management of materials in the production process. 

 
Example of a project cutting pattern 

For a presentation of the cutting diagram, watch this video. 

I. How to use 
1. Cutting pattern activation 

a. Cutting pattern generation 
To activate this cutting pattern feature, you must first activate the system report. 

Next, you need to  configure the system report. 

 

 

 

https://youtu.be/Z3tVGjm926k
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In the "Report configuration" window, click on "  Global variables" in the left-hand panel. 

In the "Cutting pattern" section, change the cutting pattern condition. Write TRUE (instead of 
FALSE). 

 
The rest of the parameters in the "Cutting pattern" section can be modified to fine-tune the 
optimization result, such as saw thickness or cutting margins. 

b. Board creation 

The second step is to create boards from the  Materials library. To do this, it is necessary 
to: 

• Go to the SWOOD library . 

• Go to Materials library . 

• Right-click on a material and click on "  Edit". 
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• In the toolbar of the Materials Library window, click on the "  Board Library" button 

(available even when SWOOD CAM is not activated). 

• In this board library, create a  new board and fill in at least the following five 
parameters: 

o «  For Board Estimation», this parameter activates the board for the cutting 
pattern. 

o “  Length” of the board used. 

o “  Width” of the board used. 

o “  Thickness” of the board used. 

o  “  Materials” of the board used. 

 
• Validate both windows. 

c. Displaying the Cutting pattern in the system report 
The final step is to integrate the Cutting Pattern into the system report, so that it can be 
visualized. To do this, it is necessary to: 

•  Generate a report. 

• In the report window, expand "    Documents" and open the HTML page "  
SYSTEM_REPORT". 
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• On the report page (for more details, see the System Report chapter), go to 
parameters. 

 
• In the parameters, go to the "Data" tab. 

• Locate "  Cutting-pattern" and click the  left arrow button. 

 
• Click on the "Apply" button (bottom right). Now the "  Cutting-pattern" tab is 

available on the left panel. 

• Click on the "  Cutting-pattern" tab. 

2. Cutting pattern interface 
The "  Cutting-pattern" tab is divided into 4 sections: 
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• Board list: Displays all board types present in the project. You can switch from one 

to another simply by clicking on it. 
• Board type name: Displays the name of the selected board type. 
• Cutting pattern: Graphic area where the parts are positioned on the board. 
• Cutting list: Displays the order of the main cuts, followed by the secondary cuts. 

Clicking on a cut displays it in the graphic area of the cutting pattern. 

 
By navigating with the ↑up and ↓down arrows on the keyboard, it's possible to switch from 
one cut to another. 

3. Export 
The cutting pattern can be exported simply by clicking on the "Print" button at the top left of 
the cutting pattern. 

Board list 
Board type name 

Cutting pattern 

Cutting list 
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This will create a layout ready for printing or saving as a PDF. This can be very useful to 
transfer to the workshop. 

 

Print 


